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1 Introduction 

 
1.1 Overview 

Thank you for choosing UnicomVault to backup and secure your critical business data.  UnicomVault 
is a remote storage solution that securely replicates your data from your PC to our Data Vaults.  
During the backup process your data is compressed to minimise the bandwidth used during transfer.  
Your data is stored in an encrypted format, using an encryption key only you know. 
 
This guide has been created to help get your critical data backed up and secured as quickly and 
easily as possible.  As well as this guide, further help can be found within the software by selecting 
Help from the Help menu. 
 
1.2 System Requirements 

Operating System 
 Microsoft Windows XP Professional and Home (Service Pack 2) 
 Microsoft Windows 2000 Professional 
 Microsoft Windows Vista (with administrative privileges) 

 
Processor 

 Required: Pentium processor 
 Recommended: Pentium III-500Mhz for more than 500 documents 

 
Memory 
Memory requirements mainly depend on the amount of files selected for backup. 

 Required: 128MB RAM above operating system and application requirements 
 Recommended: 256MB RAM above operating system and application requirements 

 
Disk Space 

 Required: 50MB plus space for local cache. 
 Recommended: Amount of free space equal to the backup account limit. The local cache can 

be as large as the total size of all files selected for backup; a file selection of 100MB needs up 
to 100MB extra disk space for the cache. 

 
Minimum Video Settings 

 800 x 600 Resolution, 256 colours 
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2 Installation and Setup 

 
2.1 Installation File 

To install the backup software simply run the installation file downloaded from our website. 
 
You will be asked where the program is to be 
installed. 
 
If you are happy with the standard location click 
‘Next’ to continue. 
 
 
 
 
 
 
 
 
 

 
 
As long as you are happy with the installation location, when this screen appears click ‘Install’. 
 

 
 
The backup software will now install.  Once 
completed click the ‘Finish’ button.  
 
When installation has completed and you open the 
software for the first time the Setup Wizard will 
start automatically.  You will need to complete the 
Setup Wizard before you can initiate any backups. 
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2.2 The Setup Wizard 

 

Step 1 of 7  
If you are installing the backup software for the first time, 
select “I want to create a new backup account”.  If you 
have an existing account that you want to reconnect to, 
select the “I want to reconnect to an existing backup 
account” option.  Click Next  to continue. 

 

Step 2 of 7 
Choose and enter your backup username, password and 
encryption key. The backup username and password can 
consist of any keyboard combination between 4 and 20 
characters. The encryption key can be any keyboard 
combination between 8 and 56 characters. Click Next . 
 
Important: Do not forget your encryption key as you will 
not be able to retrieve your data without this encryption 
key. Unicom are unable to retrieve or change your 
encryption key.  If you are uncertain about this key we 
suggest you use ‘universal’.  Should you forget your 
encryption key we will be able to remind you of our 
suggested key. 
 
If you choose your own encryption key please ensure you 
write it down and store it somewhere safe, preferably off 
site. 

 

Step 3 of 7 
Please fill out the requested details. 
 
We will check these details against your Unicom account, 
please ensure you fill out all fields accurately. 
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Step 4 of 7 
You will be asked how you connect to the internet.  By 
default the broadband option should be selected. 
 
Click Next  to continue. 

 

Step 5 of 7 
In this step you can configure the backup schedule. The 
default backup time is 19h00. It is advised to backup at 
night when the computer is not in use. The computer (and 
the modem if you are using a dial-up connection) must be 
switched on at the time of scheduled backups. With 
Skipped backups the Backup Client can notify you if you 
missed any scheduled backups. Click Next . 
 
Note: If you do not schedule any backups, you have 
to manually backup your data. We strongly 
recommend that you run automated backups. 

 

Step 6 of 7 
The next screen allows you to configure where the 
backup program should store its working files.  By default 
this screen will already be completed, if you are happy 
with the locations click Next .   

 

Step 7 of 7 
Almost there! 
 
This final setup screen will show you a summary of the 
information you have entered.  Please review it carefully, 
if any changes are required click the ‘Previous’ button.  If 
you are happy with the information click Next . 
 
Your account will then be created, and a message will be 
displayed to confirm creation was successful.  Click OK to 
close the message box. 
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3 The Backup Service 

The backup service initiates automatic backups in the background at scheduled times. You do not 
have to be logged in for the service to backup your data, as with any Windows service, but your PC 
must be switched on. 
 
If you are protecting files and/or folders with permissions, you have to ensure that the SE service is 
started with an account that has the required permissions to gain access to the files and/or folders. 
 
3.1 System Tray Runner 

 
The system tray runner monitors activity of the backup service and can also be used to select various 
options for the Backup Client.  An animated icon indicates that the service is busy with a backup 
process. 
 
When you run the Backup Client you will notice a new icon in the system tray: 
 

 
 
If you right-click on the above icon you will see the following options: 
 
Open 
Opens the Backup Client allowing you to modify your file selection initiate backups, restore files and 
configure the backup schedule. You can also open the Backup Client by double-clicking on the icon. 
 
Backup Now 
Manually initiates a backup without having to open Backup Client first. 
 
Cancel Backup  
Cancels the backup job in process. 
 
Monitor Status 
Check the current status of the Backup Client. 
 
About 
Displays a window with the product details.  Click anywhere on the About window to close it. 
 
Exit 
If you click exit the runner will be removed from the system tray, but it will not stop the backup service 
from running scheduled backups.  If you want to see the icon in the system tray again, open the 
Backup Client (via the Start menu or desktop icon). 
 

  

System tray icon 
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4 UnicomVault Backup Client 

The UnicomVault Backup Client keeps your business critical data secure.  It allows you to select files, 
initiate backups and to restore lost or corrupted files.  You can also find and restore files from 
previous backups and schedule automatic backups. 
 

 
 
While you are using the Backup Client you can select Help from the Help menu.  This will open an 
additional windowpane, to the right in the above picture, which can provide you with further 
information and assistance in using the backup software. 
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5 How to Backup 

The next sections describe how to select files and folders for backup, how to add filters to folders to 
automate the file selection of certain file types, and how to backup your files to the Data Vault. 
 
5.1 Selecting Files for Backup 

To select files that you would like to backup, click on the  tab. The folder 
structure of your computer is displayed in the left-hand pane. If you click on a folder, its contents will 
be displayed in the right-hand pane. Subfolders are only shown in the left-hand pane. Once a file or 
folder is selected for backup, any changes, additions or deletions to that file or folder are automatically 
backed up. 
 
To select an individual file: Browse to the individual file that you would like to backup. In the right-
hand pane, right-click on the file and choose Select or click in the  grey icon next to the file. A 
selected file is displayed with a  green icon. To deselect a file you can either click on the icon again 
or right-click on the file and Deselect it. Folders that have some files selected are displayed with a  
green tint. 
 
To select an entire folder: Right-click on the  folder and select Include Folder . You can also use 
the left mouse button to highlight the folder and then Include the folder from the Selection menu. 
Included folders are displayed with a  green folder. All files in the included folder and its subfolders 
are now selected for backup. Any changes made within this folder or its subfolders will automatically 
be included as well. To deselect a folder, right-click on the folder name and select Deselect Folder 
from the selection list. 
 
To exclude a file or folder: If an entire folder is included but you want to exclude a particular file or 
subfolder, right-click on the file or folder and select Exclude . Excluded items are displayed with  red 
icons or  red folders. Folders that have been selected but have some files or subfolders excluded 
are green with a  red tint. 
 
To verify the size of your backup, select Calculate Size from the File menu or click on the Size button 
in the toolbar. If your backup set is larger than your allocated limit you have to reduce the size of your 
selection. To remove files, right-click on a file that you want to exclude and click on Deselect . 
Alternatively, please contact Unicom on 0161 946 4444 to upgrade your account with additional 
storage space. 
 
If you do not want to wait for the next automated backup, you can select Backup Now from the File 
menu to manually start the backup process. 
 
5.2 Filters 

You can use filters to automate the file selection of particular file types from a specific folder and its 
subfolders. For example, a *.doc filter will include all existing Word documents, as well as any new 
Word documents that may be added later. To add a filter to a specific folder, right-click on the folder, 
select filters and choose one of the available filters from the list. 
 
A few filters have been provided for you to start with. You can create, modify and delete any of the 
filters. To modify a filter, select Filters from the Selection menu and click on Edit filters . Select one 
of the filters and Add or Remove any of the file types. The New filter option allows you to add 
additional filters. Supply a name that describes the filter and then enter the file type(s). 
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Example : AutoCAD users may want to only select their drawing files as other files generated by 
AutoCAD do not need to be backed up. The filter could be called Drawings and the filter type would 
be *.dwg . 
 
Files and folders that are included by applying a filter are displayed with  blue icons and  blue 
folders. Filtered files or folders cannot be deselected, but you can exclude particular filtered files or 
folders by right-clicking on the file or folder and then selecting Exclude . A filtered folder with 
exclusions is displayed with a  red tint. More than one filter can be applied to a specific folder. To 
remove filters from a folder, right-click on the folder, select Filters and clear the checkbox next to the 
specific filter(s) that you want to remove. 
 
5.3 Manual Backups 

After you have selected the files and folders for backup, you can manually initiate the backup process 
by selecting Backup Now from the File menu or by clicking on the Backup button in the toolbar. You 
may close the Backup Client after you have started the backup process by clicking Hide. This will not 
cancel the backup process and you can at any stage open the Backup Client to view the progress of 
the backup. You can also monitor the backup progress by right-clicking on the system tray icon and 
selecting Monitor Progress . Backup log information can be viewed in the Logs tab. Backup entries 
are displayed in blue. 
 
5.4 Backup Resume 

The Backup Client can try to resume a backup, if the previous request failed for whatever reason. If 
you select Backup Now from the File menu or you click on the Backup button in the toolbar and the 
previous backup was not successful, the Backup Client will prompt “Do you want to resume the 
failed backup? ” If you select Yes, the Backup Client will try to continue from where the process failed 
during the previous backup. Select No to initiate a new backup or Cancel to return to the Backup 
Client. 
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6 How to Restore Files and Folders 

 
The next section describes how to select the files that you want to restore, how to search for specific 
backed up files, and finally how to restore files from the Data Vault. 
 

Open the  tab. From this tab, you can gain access to your backed up files. Your latest 
backup is shown in the Last Backup folder. If you expand the Previous Backups folder, the Backup 
Client will connect to the Data Vault and retrieve a list of all previous backup dates. 
 
Select the files and/or folders you want to restore. To select a single file, right-click on the file and 
click on Select or you can click the  grey icon next to the file. To select an entire folder, right click 
on the folder and then choose Select folder . Selected files are displayed with  green icons. To start 
the restore process, select Restore from the File menu or click on the Restore button in the toolbar. 
Note: Automatic backups are disabled during the res tore process. 
 
The Backup Client will prompt for a restore location to where the file(s) must be restored. If you select 
Original location , the files will automatically be restored to the same location they were previously 
backed up from. 
 
Note: If you choose this option, the restored files  will overwrite any existing files with the 
same name in that location. You will be warned befo re the Backup Client overwrites any files. 
 
If you do not want to overwrite the current copy of these files, select the Folder option. The default 
path is a Restore subdirectory in your user account (home) folder. You can also Browse to another 
folder if you want to restore the files to a different location. 
 
6.1 Restore Options 

Recreate directory structure  
By default, the folder structure is recreated in the restore folder. If you want all files to be restored to 
one location, uncheck the Recreate folder structure option. Note: If you are restoring files from 
different folders with the same filename, you must recreate the folder structure or they will 
overwrite each other.  
 
Restore empty folders  
You can choose whether empty folders must be created if the Recreate directory structure option is 
enabled. 
 
Overwrite files  
Enable this option if you do not want the Backup Client to prompt you before overwriting an existing 
file. 
 
Use compression (faster over the Internet) 
Tick the Use compression option to enable compression. With this setting enabled, the Data Vault 
will compress the files before transferring them to the Backup Client.  
Note: You are advised to always enable this setting  if you have a slow connection to the 
Internet as the files are smaller with this option enabled.  
 
Restore log information can be viewed in the Logs tab. Restore entries are displayed in green. 
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6.2 Finding Files 

The Find files in Backups option enables you to search through your previous backups to find a 
specific file. You have the option to do a local search from your last backup, or you can connect to the 
Data Vault to search through your previous backups. 
 
To search for a file from your latest backup, select Find files in backups from the File menu or click 
on the Find button in the toolbar. Enter the filename in the textbox and click on Find. 
 
Example : If you enter help in the textbox, the Backup Client will display a list of all backed up files 
from your last backup that contain help in either the filename or the folder. 
 
Note: You can use the * and ? wildcards for advance d search queries to find the files that you 
are looking for. 
 

 
 
To search for files from previous backup sets, enable the Search through previous backups on 
server checkbox. 
 
File dates can also be specified and you can limit the number of results that must be displayed. Note: 
The Backup Date is used if you enable Search file d ates and not the file create or file modified 
dates. 
 
To restore the located files, select them individually and then click on the Restore button. 
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7 WebAccess 

 
WebAccess is a browser based interface that allows you to securely log on and access files from any 
connected computer without having to install any software. 
 
To access the WebAccess login screen, open an Internet browser and type in 
https://portal2.webaccessbackup.com/show-login.jspx 
 

 
 
The WebAccess Login screen will open and you are required to supply your backup account details.  
Supply your Group name and User name as well as your password and encryption key.  These 
details are the same details you supplied when creating your account.  For example: 
 
Group Name:  UNICOM  Always Unicom 

User Name:  PARKERPC  As chosen when you installed the software and created your 
account 

Password: PASS 

Encryption Key: UNIVERSAL 
 
Note: When reading the online Help page and you wan t to continue using WebAccess, please 
use your browsers "Back" button to return to the pr evious page. 
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From the Backups tab you can access your previous backups to retrieve the files. Note that you can 
sort the columns by clicking on the column headers. The following list describes the different buttons 
that are available. 
 

 
 
7.1 WebAccess Buttons and Functions 

 

This will download the selected files from your online backup set to the hard drive of 
the PC that you are currently using. 

 

This button will give you the opportunity to e-mail your selected files to an e-mail 
address of your choice. 

 

This button will give you the opportunity to search for a particular file in your previous 
backups. 

 

This logs the current user out of the system and gives you the opportunity to login as 
a different user. 

 
This button will give you the opportunity to read the online help. 

 
7.2 How to Download Files 

Select the files you want to download by clicking in the checkbox to the left of the filename. Then click 
on the Download button. This will prompt you for a location where to store the files on your local PC. 
After you indicate a location and filename (the files are downloaded in a ZIP file), the system will save 
the ZIP file to your local PC. 
 
7.3 How to Upload Files 

Click the Upload button and you will be presented with a screen where you can select up to 5 files to 
upload from your computer into your Briefcase. Use the 'Browse' button to indicate to where the files 
are on your computer that you wish to upload. 
 
Once you have selected all the relevant files from your computer, click on Upload . This will load the 
files from your computer into your Briefcase in the Briefcase folder that you were in prior to clicking 
the "Upload" icon on the toolbar. Bear in mind that depending on the size of the files you have 
selected, and the speed of your Internet connection, the upload may take a while. Also, bear in mind 
that there is a 5MB file size limit on files that are up loaded to your Briefcase . 
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Once the upload is complete, you will then be returned to your Briefcase and you should now see the 
uploaded files listed in the current folder of your Briefcase. 
 
7.4 How to Email Files 

Select the files you want to email by clicking in the checkbox to the left of the file name. Then click on 
the Email button. This will present you with a screen where you can enter the following information: 
 

 To: Specify email recipients here. Multiple recipient addresses can be specified, separated by 
a comma. You must specify at least one recipient. 

 Cc: Specify extra email recipients here. Multiple recipient addresses can be specified, 
separated by a comma. This field is an optional entry. 

 Subject : Specify a subject for the email that your recipients will receive. This field is an 
optional entry. If you leave it blank, the system will insert a standard subject line in the email. 

 Message : Specify a message body that your recipients will receive. This field is an optional 
entry. If you leave it blank, the system will insert a standard message body.  The system will 
also append a list of the files attached to the email, regardless of whether you specify a 
message body or not. 

 Attached as : Select whether you would like your selected files to be attached to the email as 
a single compressed ZIP file , or attached separately as Individual Files . Bear in mind that a 
compressed file is usually a lot friendlier on your mail server as well as your recipients’ mail 
server as compared to an email with the files individually attached.  Email size can sometimes 
impact the delivery time of the email to the recipients. 

 
Once you have entered the above information, click on the Send button to send the email. 
 
7.5 How to Search for Files 

This functionality works in exactly the same way as it functions on the backup client software that you 
use to backup your actual files. Simply enter a filename (or part of the name) into the text field 
provided. Note that you can also use the '*' and '?' characters as the search functionality has wildcard 
support. 
 
If you need to, you can also specify a specific date range within which to search. Next click the 
'Search' button and this will return a list of all files and the backup date that version of the file pertains 
to. 
 
Search file dates : 

 Select this option if you need to search for a file backed up within a known date range. 
Start date: 

 The date (inclusive) to start searching from. 
End date: 

 The date (inclusive) to search until. 
 
Once you have entered the above information, click the 'Search' button to find the relevant files. 
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7.6 Briefcase 

The Briefcase tab allows you to add files and folders to your account. These files will be available 
from any computer with Internet access and they do not have to be in one of your previous backups. 
Note that you can sort the columns by clicking on the column headers. The following list describes the 
different buttons that are available. 
 

 

Use this button to upload file(s) to your Briefcase. An Upload Files page will open from 
where you can browse to the file(s) that you want to upload to your Briefcase. 

 

This will download the selected files from your online backup set to the hard drive of the 
PC that you are currently using. 

 

This will allow you to create a new folder in the Briefcase. Supply a folder name and click 
on Create to create the folder. Note: empty folders (i.e. have no child folders or 
files), are discarded when you log out, or when you r session expires.  

 

Click on Delete to delete all selected files. A folder will be removed if you delete all the 
files within the folder. 

 

This button will give you the opportunity to e-mail your selected files to an e-mail address 
of your choice. 

 

This logs the current user out of the system and gives you the opportunity to login as a 
different user. 

 
This button will give you the opportunity to read the online help. 
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8 Options and Settings 

From the Tools menu option you can view and configure the primary Backup Client options and 
settings. To open this section, select Options… from the Tools menu. The various options and 
settings are grouped according to their functions and displayed in different tabs. 
 
Note: Please read through this section carefully be fore you change any of these settings. 
Incorrect settings could cause serious problems or even stop the Backup Client from backing 
up your data. 
 
8.1 Account and Security 

Account Information 
This section displays your backup account information as it is stored in the Data Vault.  You can use 
the Retrieve Settings button to update your account settings, for example when you request an 
increase to your storage limit. 
 
Account Setup 
If you need to change your password or encryption key, select either the Change Password or 
Change Encryption Key buttons. Changing your encryption key involves intensive processing on the 
Data Vault and may take several minutes. It should therefore not be done unless your encryption key 
was compromised. 
 
Security Settings 
The Security window allows you to select whether the Backup Client should remember the backup 
account password when running a backup or a restore. There are three options available: 
 

 Remember password for backup and restore : The Backup Client remembers the user 
password when doing a backup or restore. This is the default setting. 

 Prompt for password on restore: The Backup Client prompts for the user password during 
the restore process. 

 Prompt for password on backup and restore : The Backup Client prompts for the user 
password during a backup or restore process. Automatic backups are not possible with this 
setting. 

 
8.2 Connections 

Connection Settings 
In this section, you can change the connection that the Backup Client must use to connect to the Data 
Vault. You can choose between a network/permanent or dial-up connection. 
 
The Dial-up Settings button is enabled if you select the Dial-up option. Click on this button to select 
an existing dial-up connection configured on the computer, and supply the username and password 
for that Internet connection. 
 
Proxy Server 
Enable the Use a proxy server for you network or dial-up conne ction checkbox if you connect to 
the Internet via a proxy server, and supply the necessary information. 
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8.3 Backup Schedule 

The Backup Client can be scheduled to backup your selected files 
and folders automatically.  Note that if you configure the Backup 
Client to backup at night, the computer must be switched on, but 
you do not have to be logged in. The backup schedule can be 
changed by selecting Automatic Backups from the Tools Menu or 
by clicking on the Automate button in the toolbar.  
 
Use the Daily Automatic Backups  section to configure a single 
daily backup.  The Advanced Schedule  can be used to specify 
hourly backups.  Backup logs can be viewed in the Logs  tab.  
Backup entries are marked in blue. 
 

Note: You are advised not to disable automatic back ups as you will then have to manually 
backup your files. 
 
8.4 Disk Usage 

Working Folders 
If you have limited space on the drive where the Backup Client is 
installed, you can move the Cache, Logs, Temporary folders, and 
the selection database to another location. The Temp folder is used 
for temporary workspace when the files are patched, compressed 
and encrypted, the Logs folder stores all backup and restore logs, 
and the Cache folder keeps a local, compressed and encrypted, 
copy of the selected files for a specified amount of days.  The 
selection database compares the latest backup selection with the 
previous backup to determine the changes. 
 

Note: Always keep these folders and the selection d atabase on the same drive. If you move 
these options to a network share, please ensure tha t the Backup Client has the correct 
permissions to reconnect to that share. 
 
Cache 
When modifications are made to a file, the Backup Client only transmits the changes to that file, as 
opposed to transmitting the complete file again. This is accomplished by keeping a compressed copy 
of the file in a local cache and then using a sophisticated patching technique to extract the difference 
between the file in the cache and the one ready to be backed up. 
 
Files are only kept in the cache for a certain amount of days. Files are added to the Cache folder if the 
file was modified within the Days to keep files in Cache window. Once a file has been flushed from 
the cache, a full copy must be backed up when any modifications are made to the file. The longer files 
are kept in the cache, the better the chance of only transmitting patches instead of full copies and 
thus reducing the amount of data that needs to be transmitted.  If you have limited disk space, you 
may want to consider shortening the time files are kept in the cache. 
 
Note: If you select 0 days, patching is disabled, a ny files in the Cache folder will be deleted, 
and complete files are backed up to the server duri ng each backup. 
 
To delete the current cache, use the Clear Cache… button. If you delete the cache, full copies of your 
selected files will be re-sent to the server during the next backup. You may notice that the Backup 
Client will log the message Doing monthly cache cleanup once a month. This maintenance task is 
to ensure that the cache folder is up to date by deleting any files that fall outside the Days to keep 
files in Cache window. 
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8.5 Performance and Limits 

Processor Usage and Disk Access 
The Backup Client uses a fair portion of the available processor power to patch, compress and 
encrypt files during the backup process. If you use the computer at the same time, you may 
experience some performance deterioration. You can lessen this effect by lowering the Processor 
Usage. 
 
Disk Access is another setting that you can modify to limit performance deterioration. If this setting is 
set to high, the Backup Client will continuously use all available disk access to write to the disk, 
ensuring that the process completes as fast as possible. The process will take longer if you lower this 
setting but your other applications will still function without any interruptions. 
 
Limits 
Outgoing transfer limit - The outgoing transfer bandwidth can be limited (in kBytes/second) in case 
you need to allocate only a certain amount of bandwidth to the Backup Client. 
 
Backup size restriction - You can limit the total amount of data that may be transferred during each 
backup.  Please note that if you enable this option, it may take several backups before all your files 
are backed up to the Data Vault. This feature is especially useful if you have a poor Internet 
connection and you encounter problems with transferring large backups. 
 
8.6 Advanced Options 

Options and Retries 
The Backup Client can be configured to Always connect to the Data Vault during each backup to 
update its last backup date stamp, even if there were no changes made to the backup set. With this 
setting enabled, the Data Vault will always be up to date with the latest backup date. 
 
Enable Volume Shadow Copying to backup locked files  enables you to backup locked files 
without using third party open file management software. This is currently only available on Windows 
XP and Windows 2003 Server Operating Systems. 
 
Number of Backup/Restore attempts before cancelling  - By default, the Backup Client tries to 
connect to the Data Vault four times before cancelling the backup process. If you have a poor 
connection to the Internet, you may want to consider increasing the number of attempts. The backup 
will continue from the previous point of failure. It will not resend the entire backup.  
 
Connection Retries - By default, the Backup Client will try to reconnect to the Data Vault after 60 
seconds, should the connection be dropped. This setting enables you to increase/decrease the 
duration between the retries. 
 
Socket Timeout - The socket timeout is, by default, 60 seconds. If the Backup Client is connected to 
the Data Vault and there is no communication between the two, this amount (in seconds) is the 
duration that the Backup Client will stay connected before dropping the connection. 
 
  



 
 

20 Options and Settings | UnicomVault 
© Universal Utilities, UnicomVault Setup Guide, Version 1, July 2008 

8.7 Logging 

The Logs  tab provides information about each backup 
and restore.  This section enables you to modify the 
structure of these log files.  You will notice an 
additional toolbar button when you open the Logs tab; 
the Summary button can filter the information to only 
display the last 14 lines. 
 
You can specify the level of information that must be 
included in the log files. Choose between: 

 Log all messages 
 Suppress detail messages 
 Log errors and warnings 

 
Enable the Include date in log file time stamp  
checkbox to add the date to the backup and restore log 
files. 
 
Automatic Log File Deletion 
A log file retention period can be enabled to delete files older than, for example, 30 days by enabling 
the checkbox and specifying the duration in days. 
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9 Additional Settings 

The Tools menu provides you with various options and settings that you can modify to enhance and 
streamline your Backup Client. You can also modify your account settings from this menu. 
 
9.1 Health Check 

The Backup Client Health Check provides information to pre-emptively highlight possible issues, for 
example free disk space problems or SE service access rights to files and folders. It can also provide 
the estimated line speed to the Storage Platform. Five sections are available: 
 

 Memory  – Memory utilisation statistics from the last backup as well as overall memory usage 
to date. 

 Data Protected  – Information includes the number of files and directories selected for backup. 
 Disk Usage  – Free space availability for all local drives. 
 Line Speed  – Line Speed estimate to the FileServer by transmitting data for 10 seconds. 
 Service Rights  – Information about the service account name and access rights to the 

working folders. 
 
You can decide which checks you want to run by enabling/disabling the checkboxes next to the 
entries. Use the Show Last Health Check  button to see the last report. You have the option either 
Print  or Export  the Health Check reports. 
 
9.2 Snapshot Backup and Restore 

SnapShot Backup and Restore enables you to create a backup of your selected files on disk or to a 
local SnapShot server within your Local Area Network (LAN). This SnapShot data can then be moved 
to the server running the Data Vault where the data will be transferred. 
 
The Data Vault is usually hosted at an off site Data Centre and this feature enables the backup 
administrator to reduce the initial backup window if there is a large amount of data that must be 
backed up, typically across a slow internet/network connection. 
 
A similar procedure can be followed when restoring a large amount of data, for example, during a 
Disaster Recovery. 
 
9.3 Archive References 

Archive References enables you to view backups that have been archived to another storage device, 
e.g. to tape. These files are marked with a greyed-out folder in the Restore tab. You can search 
through the available archived backups, but they cannot be restored from the Backup Client. After you 
have found the files that you want to restore, contact your backup administrator and request that the 
archived backup is moved back to the Data Vault. Thereafter you will be able to restore the files. 
 
9.4 Dynamic Profiling 

Dynamic Profiling enables Unicom to propagate certain client side settings from the Data Vault to your 
Backup Client. Note: These settings take priority over any settings specified in the Backup Client. 
These settings include: 
 

 Changing the backup schedule 
 Specifying system file exclusions 
 Adding additional filters to the filter list 
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When the Backup Client connects to the Data Vault, it will receive a list of any Dynamic Profiling 
settings specified by the Backup Administrator and these changes will be implemented in the Backup 
Client. If you modify any of these settings with Dynamic Profiling enabled, it will revert back to the 
Dynamic Profiling settings during each backup. 
 
9.5 View: Look & Feel 

You have the option to change the look and feel of the Backup Client. From the View menu, go to 
Look & Feel and select one of the available options. 
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10 Security 

Attix5 Backup Professional uses a combination of Blowfish encryption and SSL secure data 
transmission to ensure the safety of your data. 
 
When the Backup Client has to transfer data to the Data Vault, it connects using a secure SSL (1024 
bit RSA key exchange, 128 bit RCA stream cipher and SHA-1 integrity checking) connection to 
transfer the data. Signed SSL certificates and Certificate Revocation Lists (CRLs) are used to verify 
server integrity. 
 
Data is stored using 448-bit Blowfish encryption to encode the data on the Server. This is 
considerably greater than the encryption used for Internet banking and online credit card transactions. 
 
Your encryption key is seen as a passphrase by the Data Vault. A random encryption key is 
automatically generated when any account is created and this random key (and not the passphrase 
specified by you) is used to encrypt your files. 
 
The encryption key is protected by the passphrase (your encryption key) and without this passphrase 
you cannot decode the actual encryption key. When you change the encryption key in the Backup 
Client, the actual key is decrypted and re-encrypted with the new passphrase. 
 
The data is never touched. All data since the initial backup is encrypted with the same random 
encryption key even when the passphrase is changed. If you change your encryption key, you do not 
have to remember the previous encryption keys for future restores – the Backup Client will be able to 
retrieve the data from the Data Vault. 
 
Your encryption key is not stored anywhere on the D ata Vault, and is only known to you. If you 
forget this encryption key, it will render your dat a unrecoverable. 
 
Security standards and techniques employed by Attix5 Backup Professional were audited by 
PricewaterhouseCoopers to ensure that sensitive corporate data remains safe from prying eyes 
when transferred over the Internet or stored on a server. 
 
10.1 Blowfish Encryption 

Blowfish is an encryption algorithm. It is a symmetric block cipher, which uses a variable-length key 
from 32 bits to 448 bits. Backup Professional uses the maximum strength 448-bit key. The Secure 
Sockets Layer (SSL) is a commonly used protocol for managing the security of data transmission. 
Attix5 Backup Professional makes use of the SSL protocol (1024 bit RSA key exchange, 128 bit RC4 
stream cipher and SHA-1 integrity checking) for secure communication between the Backup Clients 
and the Data Vault, including data transmission. 


